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WordsFlow 3

This updated plug-in removes all the pain of placing
and updating Microsoft Word documents

PLACING MICROSOFT WORD FILES INTO
InDesign just might be the most common
chore production designers do on a
day-to-day basis. And often, no sooner
do you get the text placed, formatted,
and styled when you find out it needs

to be updated with edits, additions, and
deletions. Em Software’s WordsFlow has
long been a tool that makes this process
easier through its dynamic linking and
sophisticated merge technologies. Best
known for its non-destructive merge-
update feature, WordsFlow allows you to
merge updates in a story in InDesign to a
linked Word file that has been changed,
edited, or updated without losing any

BY Jamie McKee

of the edits or formatting applied to the
text in InDesign. Although InDesign will
happily let you update a linked Word file,
doing so without WordsFlow results in
edits and formatting changes made in
InDesign being totally removed, making
the feature essentially worthless. Many a

user has been frustrated by this limitation,

which WordsFlow thankfully solves.

The recently released WordsFlow 3
supercharges the plug-in’s abilities with
a new Microsoft Word import filter and
advanced import options. The Pro version
of WordsFlow 3 also works with imported
Excel spreadsheet files and provides addi-
tional linking and export options.
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Getting Started

Once you install WordsFlow
and restart InDesign, the
WordsFlow Word filter is enabled
by default—whether you use
InDesign’s Place command or
choose WordsFlow > Place
with WordsFlow (FIGURE 1). New
to WordsFlow 3 is a preference
(found in InDesign’s Preferences
dialog box) to turn it off, which
will disable WordsFlow’s linking
feature on future documents you
place. However, link updates or
relinks of stories that were orig-
inally placed using WordsFlow
will continue to use the plug-in.
Additionally, you can revert to
using InDesign’s native Word
import filter with the Place
without WordsFlow command
found in the WordsFlow
submenu. (Previously, the only
way to accomplish this was by
uninstalling WordsFlow.)
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FIGURE 1. Access WordsFlow functions using the options in the WordsFlow submenu.

File Edit Layout Type Object Table View Window Help

Adobe InDesign 2021

Place with WordsFlow...
Place without WordsFlow...
Update Linked Document

Export with WordsFlow...
Export with WordsFlow and Edit...

Edit Import Options for Document...

Visit User Guide

Visit Product Page
Visit Product News
Send Email to Support

About...

WORDSFLOW 3

The most significant change to
WordsFlow 3, however, is the use
of a new Microsoft Word import
filter designed from the ground
up by Em Software to provide
a superior, more manageable
experience when placing and
updating Microsoft Office Open
XML (DOCX) documents. The
older Word format (DOC), as
well as RTF and TXT files, will
continue to be imported with
Adobe’s filter.

Even more impressive,
WordsFlow can place any Open-
Document Text (ODT) file, such
as those created with LibreOffice,
OpenOfhce, NeoOffice, Word
Online, and even Google Docs.

WordsFlow 3’s import filter
works better than InDesign’s
native Word import filter
in several ways, including
advanced style mapping and
improved import speeds. Plus,
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this technique allows the devel-
opers to directly address any
issues that might come up, rather
than relying on Adobe.

Word Document Import
Options with WordsFlow

If you've ever used Em Soft-
ware’s DocsFlow 3 plug-in
(see my review in Issue #133),

you'll immediately recognize
WordsFlow’s new Word
Document Import Options
dialog (FIGURE 2). You can access
the import options by selecting
the Show Import Options
checkbox when using either
InDesign’s Place or the Place
with WordsFlow dialog box.
You may be aware of the
shortcut of holding the Shift key
when clicking Open to access
the Import Options dialog box,
even when the checkbox is not
enabled. Note that this works
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FIGURE 2. WordsFlow's Word Document Import Options work similar to Em Software’s DocsFlow Import Options.

Word Document Import Options

Presets

[Default]

General General
Paragraph
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Table Import Objects

Cell Footnotes

Object Endnotes

[ Index

Style Mapping Summary:
Paragraph Table
Normal Normal Table

‘Word Document Import Options

Presets

[Default]

General Table

Paragraph

Character Word styling InDesign style
Table Normal Table (default) MNormal Table
Cell

Object

( aaa )

Preserving Overrides on Unmapped Tables

Border Color
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Word Document Import Options

Presets
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Paragraph

Character Word styling InDesign style
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Object
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[ Space Before/After Paragraph
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First Line Indent
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Word Document Import Options
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Paragraph

Character Word styling InDesign style
Table

Cell

Object
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( Add )

Preserving Overrides on Unmapped Cells
Inset

B Background Color

Cell Edge Color

Paragraph Style

Word Document Import Options

Character
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(o)
Preserving Overrides on Unmapped Text
Font Family, Font Size, and Font Color
Underline and Strikethrough
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Applied Language
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‘Word Document Import Options.
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only when using InDesign’s Place
command; it will not work when
using the Place with WordsFlow
command. When I asked Em
Software why, they replied they
didn't even know the shortcut
existed, but they agreed it should
be added.

At the top of the dialog box are
controls to create and choose
Presets, like those in InDesign’s
Word Import Options dialog box.
However, any presets you've
saved using InDesign’s Word
Import Options will need to be
recreated using WordsFlow’s
Import options, as there’s no way
to move them into WordsFlow.

There are options specific to
each Import method (InDesign’s
or WordsFlow’s) that may
influence which method you use.
For instance, one thing unavail-
able using WordsFlow is the
ability to import Word endnotes
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as static text, a feature I use
frequently since I find InDesign’s
handling of endnotes abysmal.
(See my articles on endnotes in
Issue #105 and #117.) InDesign
also allows you to automatically
convert straight quotes to typog-
rapher quotes, choose whether

or not to import inline graphics,
unused styles, or tracked
changes, and whether to convert
bullets and numbered lists to
text—none of which are available
as WordsFlow import options.

Map Paragraphs with

Style Name: Paragraph
Left Indent: 0.5 inches
Alignment: (Any)
(Any)
(Any)
(Any)
(Any)

(Any)

Background Color:
Border Color:
Border Width:

Location:

List Type:

Paragraph Style Mapping

To InDesign Style

On the other hand, the style
mapping support offered by

WordsFlow is unparalleled. Not

only can you do straight 1-to-1

style mapping as you can using

InDesign’s import options,
but you can also choose any
combination of seven other

variables applied to a Word style

when mapping to an InDesign

style. For instance, say you
need to flow a chapter of text
into InDesign where the style
named Paragraph was applied

Text- Indented Style Name:

. 2 Left Indent:
Preserving overrides

Space Before/After Paragraph Alignment:
Left/Right Indent

First Line Indent

Background Color:

Border Color:
Line Spacing (Leading)
= - < Border Width:
Justification (Left, Center, ...)
Paragraph Border Locatlon:

Tabs List Type:

( Cancel )

Map Paragraphs with

Paragraph
None
(Any)
(Any)
(Any)
(Any)
(Any)
(Any)

WORDSFLOW 3

to indented text in Word, which
uses a left indent of .5 inches.
However, that same Paragraph
style was also applied to text
that was set with no indent.
You could go through all your
text in either Word or InDesign
and apply a different paragraph
style to the flush left text. But
with WordsFlow, you can
simply define the different Left
Indent settings to be mapped
to a different style in InDesign
(FIGURE 3). WordsFlow also

Paragraph Style Mapping

To InDesign Style

Text- No Indent

Preserving overrides

Space Before/After Paragraph
Left/Right Indent

First Line Indent

Line Spacing (Leading)
Justification (Left, Center, ...)
Paragraph Border

Tabs

( Cancel )

FIGURE 3. Using WordsFlow, you can fine-tune your paragraph style mapping options using seven other criteria options.
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allows you to apply InDesign
styles while preserving certain
overrides, such as Space Before/
After, Justification, or Tabs.

The extensive level of control
offered through WordsFlow is
quite amazing!

Believe it or not, it gets even
better. Using WordsFlow, you
can now easily map local format-
ting applied in Word to character
styles in InDesign. Not only can
multiple fonts, font sizes, and/
or text colors be mapped to a

Character Style Mapping

Map Text with
Style Name: | (Any) e Italic
Font: (Any)
Text Color: (Any)
Bold: (Any)

Italic: On

Font Style (Regular, Bold, Italic, ...)

Position:  (Any)

Capitalization (AllCaps, SmallCaps, ...)

Line Across: (Any)

Font Size:  (Any)

Tracking
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Preserving Overrides

Underline and Strikethrough
Superscript and Subscript

Applied Language

Horizontal Scale

character style, but the often-
used italic, bold, and underline
local formatting options in Word
(or any combination of the three)
can be mapped to InDesign
character styles too (FIGURE 4). It
you rely on character styles to
format text, this can save you a
ton of time.

All style mappings you create
are listed in the main window
and are run in the order they
appear (FIGURE 5). You can move
individual style mappings up or

To InDesign Style

FIGURE 4. WordsFlow
allows mapping

of various local
formatting options
in Word to InDesign
character styles.

Font Family, Font Size, and Font Color

.,
( Cancel ]'

down the list, which is important
to make sure your mappings are
caught in the proper order. For
instance, you would want to run
a bold+italic mapping before
running either just the bold or

Presets

Unformatted Documents

General Character

Paragraph
Word styling

Bold=0n, Italic=0n
Bold=0On
Italic=0n

Character
Table
Cell

Object
Position=Superscript

Word Document Import Options

Superscript

WORDSFLOW 3

italic. Otherwise the import
options will identify the bold/
italic in your bold+italic text and
apply just the bold or italic style
mapping, thus overriding your
bold+italic style mapping.

| G

InDesign style
Bold Italic

FIGURE 5. Be sure
to order your style
mappings carefully
S0 as not to cancel
others out.

Preserving Overrides on Unmapped Text

Font Family, Font Size, and Font Color

Underline and Strikethrough
Superscript and Subscript

Font Style (Regular, Bold, ltalic, ...)

Capitalization (AllCaps, SmallCaps, ...)

Applied Language

Horizontal Scale

Tracking
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Tables in Word can be mapped

to table Styles in InDesign based Map Tables with To InDesign Style Map Cells with To InDesign Style
, . . Style Name: (Any) . 2 Column Table . Background Color:  (Any) ¢ Header
on the table’s color. Likewise, —— (Any)
: Y Preserving Overrides Black Preserving overrides
lls in Word can b d -
cells in Word can be mapped to e Border Color White Inset
. i Red Background Color
InDesign cell styles based on the i Yellow Call Edge Color
, Yell Green
cell’s background color (FIGURE 6). o e i
Cyan e
WordsFlow even takes a stab at e Magenta

Magenta

applying InDesign object styles
to images or grouped items
(FIGURE 7).

FIGURE 6. WordsFlow now allows you to map Word tables to InDesign table and cell styles, based on the table’s and cell's color.

Merged Updates

As mentioned earlier, Words-

Flow’s rai ‘étre is i " \X/ d
© S raison d et €13 tS Map Objects with To InDesign Style MOV lng ‘ TeXt : From ! Or ‘ tO ‘
merge-update feature. After Type: |y Nonel
y ) ¢ Notes

you've performed a merge- image IDDGSi rﬂ(Zﬂ * Author: Wordsflow
update, it’s a good idea to check Crouped tems g SR PR

’ Modified: 2/2/21 at 1:42 PM
for conflicts in your story. by Jamie McKeer — NoteNoi 1 of 1

. ‘ ): r HILE - SOME- INDESIGN - USERS - FOCU . .
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[\-'pCﬁC[TL‘I',- spend most-ol-my-tume- v

sheets-are-great,-editors-don’t-submit-text-in-Inf Conflict-alert:- Insertions-were- made -here by-both-
Afterspending too-many hours-applying InDesll the external document:(left: InDesign)-and:

better way. ) InDesign-(right:- K2)#
[.developed-a-method for-synchronizing-sty

View > Extras > Show Notes or

by using the Notes Panel’s Show/
Hide Notes button (FIGURE 8).

FIGURE 7. You can map images or grouped items FIGURE 8. WordsFlow shows
You can review the Notes and in Word to InDesign object styles. merge-update conflicts in
decide how you want to handle the Notes panel.

them. From the Note panel’s
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menu you can delete Notes indi-
vidually as well as completely
remove Notes from your story.
When there are conflicts in

this merge-update process, the
external Word document always
“wins” for content order while
the InDesign story always “wins”
for formatting.

Export Like a Pro

The Pro version of WordsFlow
provides additional export capa-
bilities. With a story selected,
choosing File > WordsFlow >
Export with WordsFlow will
export it as a new DOCX file and
automatically link the newly
created document as if it had just
been placed in the original story.
This is handy for taking existing
InDesign content and saving it
out in Word format for further
editing and revision. While
WordsFlow doesn’t currently
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supply export-specific options
for Word exports, the format-
ting of the story will follow the
contents as closely as possible.
Optionally, you can choose
the Update Linked Document
command from the WordsFlow
menu to send your final story
contents back to your original
Word document, rather than
creating a new one. In essence,
the Pro version of WordsFlow

allows authors and editors to
work in parallel with production
and layout without duplicating
or losing work—and all without
needing to introduce new
programs or change worktlows!
Besides these additional export
options, the Pro version also
adds one-way Excel function-
ality, similar to what it offers for
Word—updates to Excel data
can be made to InDesign tables

\'I

TIP: SHOWING NOTES IN THE LINKS PANEL -Q-

If you enable the # of Notes column in your Links panel, you can
see how many Notes are in your story at a glance. To enable this
column, open the Links panel and select Panel Options from the
panel menu. In the Panel Options dialog box, scroll down to the
bottom to locate the Show Column option and turn it on. Also, keep
in mind that using the Story Editor (Edit > Edit in Story Editor)
may be easier than working with Notes in the formatted text.

WORDSFLOW 3

without losing any formatting
work, along with notification of
any conflicts.

The Final Word

WordsFlow 2 was already a
terrific plug-in for InDesign. The
addition of the new Word import
filter introduced in WordsFlow 3
gives you unmatched style
mapping abilities, even for
locally formatted text, while
maintaining its terrific linking
and merging capabilities.

If you spend a lot of time
wrangling text files placed into
InDesign, there’s no doubt that
WordsFlow 3 will save you time
and trouble.

Jamie McKee is a teacher, book designer,
and typesetter for university presses

and publishing companies globally. You
can find more information about him at
mackeycomposition.com.
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